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Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before 
installing software or attempting to use the Avid Unity ISIS™ (Infinitely Scalable Intelligent 
Storage) system. This ReadMe provides information that is not in the other Avid Unity ISIS 
documentation.

n Search the Avid Knowledge Base for the most up-to-date ReadMe file, which contains the 
latest information that might have become available after the documentation was published.

This document provides hardware and software requirements, a hardware overview, and 
other important information not available in other documentation. This document also lists 
limitations and known issues. Physical connection of the system and loading of the system 
and client software is explained in the Avid Unity ISIS Setup and Configuration Guide 
located on the Avid Unity ISIS Documentation DVD. You should read this Avid Unity ISIS 
ReadMe prior to connecting the Avid Unity ISIS system and loading the software.

c Avid strongly recommends that you purchase installation with your Avid Unity ISIS 
system. Installing the Avid Unity ISIS system yourself could void your warranty.
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If You Need Help

If you are having trouble using Avid Unity ISIS system:

1. Retry the action, carefully following the instructions given for that task. It is especially 
important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after 
the documentation was published. Also check online for the most up-to-date ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online ReadMe, select ReadMe from the Help menu, or visit the Knowledge 
Base at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 
24 hours per day, 7 days per week. Search the Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

Symbols, Conventions, and Nomenclature

ReadMe documents use the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

t This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Ctrl+drag.

http://www.avid.com/onlinesupport
http://www.avid.com/readme 
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If you are unfamiliar with the names of the Avid Unity ISIS components, the table provides 
the terms used in this and other Avid Unity ISIS documents.

Product Nomenclature   

Product name Term used in this document

Avid Unity ISIS media network System or shared network storage environment 

The Avid Unity ISIS consist of the hardware, Avid software, and 
other hardware supplied by the customer, such as external Ethernet 
switches The avid hardware is shown in the following figure.

Avid Unity ISIS architecturea Architecture - including software

Avid Unity ISIS file systema Group of bound storage elements 

Avid ISIS™ storage blade, i500, i1000 ISIS Storage Blade ISB

Avid ISIS Integrated Ethernet switch blade ISIS Integrated Switch (ISS) 

Avid ISIS Expansion Integrated Ethernet 
switch blade

ISIS Integrated Expansion switch (IXS) 

Integrated Power supply and Cooling fans Power supplies

Avid ISIS Engine The chassis that contains the ISBs, ISS, IXS, power supplies, and 
an internal midplane.

Avid Unity ISIS System Director (Active 
and Secondary)

System Director A CPU connected to the ISS to manage the 
servers and portions of the metadata to the System Director 

Zone 1, Zone 2, and Zone 3 Configurations These are Avid defined client configurations that connect the client 
to the Avid Unity ISIS system. A complete explanation can be 
found in the Avid Unity ISIS Setup Guide.
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The major components used to create the Avid Unity ISIS media network are a System 
Director, an engine containing ISIS Integrated Switch (ISS), ISIS External Switch (IXS), 
ISIS Storage Blade (ISB), and one or more clients. 

Avid Unity ISIS Media Network Hardware

New Features In Version 1.1
Along with many performance improvements, the following is a list the new features in 
Avid Unity ISIS v1.1. 

• 10-Gb Link Aggregation — Sometimes called “trunking,” link aggregation allows you 
to combine physical network links into a single logical link for increased bandwidth. 
Link aggregation can increase the capacity and availability of the communication 
channel between devices (both switches and clients) using existing Ethernet 
technologies in such a way that two or more Ethernet connections can be combined to 
increase the bandwidth capability and to create resilient and redundant links. Link 
aggregation also provides load-balancing where the processing and communications 
activity is distributed across multiple links so that no single link is overwhelmed. 

System Director front view

Rear view Front view

ISIS Integrated Switch (ISS)

ISIS Integrated Expansion Switch (IXS)

ISIS Storage Blade (ISB)

Power supply

Engine
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• Administrator tool enhancements — The Administrator tool includes the following new 
features:

- A Home page provides quick access to most of the Avid Unity ISIS tools, including 
the Administrator tool, the System Monitor, the Log Aggregator, the Switch 
Manager, the Disk Tester, and the Connection Analyzer.

- The default column layout in the Main display area includes a basic set of headings 
to allow you can view standard information quickly. You can customize the Main 
display area to view all available column headings, or to hide or show columns,

- You can sort and filter the items in the Main display area in the Administrator tool.

- You can rearrange columns in the Main display area.

• File Structure Integrity Check — You can send a command to the storage element check 
the integrity of the file structure and rectify its files, in addition to the automatic process 
of rectifying files that the system conducts periodically. Rectifying files allows the ISBs 
to communicate with the System Director to monitor the state of its storage and clean up 
any files that the ISB no longer needs to store.

• Client Manager — The Avid Unity ISIS Client Manager has been redesigned to include 
added functionality. The Client Manager allows your client system to connect to the 
Avid Unity ISIS media network, to mount and access your workspaces at any time, and 
to manage your workspaces. The Client Manager allows users with the necessary 
account privileges to resize workspaces, to protect and unprotect workspaces, and to 
specify client bandwidth reservations, if any.

• Increased storage capacity for the Avid Unity ISIS media network — The media 
network now provides up to 192 terabytes (TB) of storage, or 96 TB of mirrored 
storage. The Avid ISIS Engine contains either two 250 GB ISBs or two 500 GB ISBs.

• Increased file management — The System Director handles file management for the 
system, which can support a configuration including the following:

- 1000 user accounts

- 2,500,000 total files

- 10,000 folders

- 10,000 files per folder (typical)

n The files and folders compete for space so, more files relates to less folders and vice versa. 
Maximum numbers depend on the number of folders, the number of files in folders, and even 
things like the length of file names.

• Support for Macintosh® clients — Avid Unity ISIS now supports Macintosh G5 Avid 
editing systems as clients on the media network using the build in Ethernet port.
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• Increased client capacity — Avid Unity ISIS supports up to 300 clients (150 active 
clients), each using dual-stream DV 50 video and up to 8 tracks of audio.

Connected Active 

- Reading and writing to Avid Unity ISIS File System (using bandwidth) 

- License Key is deducted from the total

Connected Inactive

- Avid Unity ISIS workspace mounted however, not reading or writing 

- License Key is deducted from the total

Disconnected

- Connection Manager has not been started or client is logged out 

- License Key is not deducted from the total

• Avid Unity ISIS Agents — The Switch Blade Agent includes the following features:

- Port information is displayed and grouped by chip (reflecting the physical location 
of ports on the switch) and by function (for example, as client ports or stacking 
ports).

- Link aggregation configuration is displayed. You can also create, modify, and delete 
link aggregation configurations.

• Replication Status — The Avid Unity ISIS System Director Control Panel now includes 
information on replication status for the system.

• Network Time Protocol (NTP) — You can now configure your Avid Unity ISIS 
components to use NTP server to keep all ISSs and ISBs in synchronized time.

Upgrade Instructions For v1.1

The process for upgrading from Avid Unity ISIS v1.0x to Avid Unity ISIS v1.1 has change 
from previous upgrades. 

n When installing the software on a Windows 2000 clients make sure you first run Windows 
Update and accept all “High-priority Updates” and install Windows msi 3.1. If Windows 
msi 3.1 is not installed, you might receive an error message informing you that a required 
DLL is missing while installing the client software.

The upgrade process from v1.0x to v1.1 is summarized as follows:

1. Upgrade System Director software and load the Installers on the System Director as in 
previous releases. For more information, see the Avid Unity ISIS Setup Guide.

2. Upgrade all your ISSs, make sure each ISS finishes its upgrade before continuing with 
the ISB upgrades.
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3. Upgrade your ISSs and wait until every ISS is at the “Install Waiting” state and then 
power down all the Avid ISIS Engines. 

4. Power all the Avid ISIS Engines back on at the same time. 

After the Avid ISIS Engines restart, the ISSs continue with the install (no additional user 
intervention is necessary).

Memory Error Status

The Administration Tool now has the ability to display Memory Error status as part of the 
complete ISB status on the Storage Elements page. You can also view ISB status by placing 
the mouse pointer over a component in the Avid Unity System Monitor tool. This status is 
used as an indicator for an ISB failure. Replace any ISBs that return a Memory Error status.

After upgrading the System Director to v1.1, the ISBs initially show a status of “Disk 
Performance Degraded” while upgrading the ISBs. Once the ISBs are upgraded to the same 
version (v1.1), the ISB status is valid again.

Upgrading Unstacked Switches to v1.1

If you need to upgrade switches that are not yet stacked, perform the following steps The 
procedure requires possible changes to System Director IP addresses.

To upgrade unstacked switches:

1. Note the System Director’s current IP address on the left and right side of the network. 
Save this information for restoring the System Director’s IP information. 

2. Unplug the System Director’s connection from both the left and right side of the stacked 
configuration and give the System Director IP addresses on the same subnet as the new 
switches. For example 192.168.10.250 (left) and 192.168.20.250 (right). 

3. Plug the left and right connections from the System Director into the new left and right 
switches.

4. Perform the upgrade from the Administration Tool on the System Director.

5. Repeat steps 2 to 4 for the remaining unstacked switches.

6. When all switches are upgraded to v1.1, plug the left and right System Director 
connections back into their original places in the stack.

7. Restore the original IP addresses for the System Director’s left and right connections.

You can now expand an eight engine Avid unity ISIS network to a twelve engine Avid unity 
ISIS, see the Avid Unity ISIS Setup Guide.
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Hardware and Software Requirements
The following table provides a list product clients and required software versions needed to 
work with Avid Unity ISIS v1.1. 

n All Windows editing clients must use the 1-Gb Intel® Pro 1000 MT Ethernet board to 
connect to the Avid Unity ISIS system. For instructions on installing the board and software, 
see Avid Unity ISIS Client Manager Guide.

Editing Client Requirements for Avid Unity ISIS  

Software Release Number Required Hardware

Media Composer® 1.6.3, and 1.6.7, 1.6.8, 2.1.8, 
2.1.9, 2.2, 2.2.1, 2.5, and later

1.8.4 on MacOS 10.4.3

2.5 and later on MacOS 10.4.6

Dual Processor HP XW8000 or HP xw8200

Macintosh G5 systems

Avid iNEWS Instinct™ 1.0 and later Workgroup Environment

Avid Interplay™ 1.0 and later Workgroup Environment

Avid Symphony™ Nitris® 1.0 and later Standalone and Workgroup

NewsCutter® Adrenaline and 
NewsCutter XP

6.1.8, 6.1.9, 6.2, 6.2.1, 5.6.3, 
5.6.7, and 5.6.8, 6.5, and later

Dual Processor HP XW8000 or HP xw8200

Media Composer Meridien v12.5 Single Processor HP XW8000 with 3.06 or 
2.8 GHz CPUs or single processor 
Compaq® W8000 with 2.8 GHz CPU.

NewsCutter Effects/XP Meridien Effects v4.5 
XP v3.8.13

Single Processor HP XW8000 with 3.06 or 
2.8 GHz CPUs. Single processor 
Compaq W8000 with 2.8 GHz CPU.

Avid Xpress® Pro 5.2.1, 5.5 and later

4.8.4 on MacOS 10.4.3

5.5 and later on MacOS 10.4.6

Standalone, not in a Workgroup environment.

Macintosh G5 systems

Avid Unity MediaManager v4.5.3, 4.5.4, and later SR2200a or SR2400b

Avid Unity TransferManager v2.9.6, 2.9.7, and later SR2200c or SR2400d 

AirSpeed® v1.5.2 and later

CaptureManager v2.7.1.1, 2.7.2.2, and later
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Laptops and Switches

For the latest list of qualified laptop systems for use with Avid Unity ISIS, check the Avid 
Knowledge Base.

To access the Knowledge Base:

1. Access the Knowledge Base at www.avid.com/onlinesupport/.

2. Click all documentation > other docs.

3. Click the Browse by menu and select Unity ISIS.

4. Click go.

Avid supplies the following layer 2 and layer 3 switches used in a Zone 2 and Zone 3 
configurations.

• Cisco 4948-10GE containing 48 1-Gb ports and two X2 based 10-Gb ports (Avid 
supports both LR and SR X2s) 

• Foundry FESX424 containing 24 1-Gb ports and two XFPs based on 10-Gb ports (Avid 
supports both LR and SR XFPs)

• SMC 8724ML3 containing 24 1-Gb ports and no 10-Gb ports

n Access the Knowledge Base as previously described, to download the Avid Unity ISIS 
Qualified Switch Reference Guide. This document provides configuration information on 
the Ethernet switches that are qualified with the Avid Unity ISIS media network.

Network Connection Speed

Avid Unity ISIS no longer supports 10/100 BASE-T network interface connections. For 
more information, see “Client Connection Speed” on page 21.

a. When MediaManager uses the SR2200 it must use the Intel Pro 1000 MT board to connect to the Avid Unity ISIS 
system.

b. When MediaManager uses the SR2400 it must use built-in dual copper Gig-E connectors to connect to the Avid Unity 
ISIS system.

c. When connecting to the Avid Unity ISIS system you use two dual Intel Pro 1000 boards. One for the Avid Unity ISIS 
system and the other to other devices.

d. When connecting to the Avid Unity ISIS system you use the built-in dual copper Gig-E connectors, but must use the 
Intel Pro 1000 MT (copper) or MF (Optical) to connect to other devices.

http://www.avid.com/onlinesupport/
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Loading the System Software

The Avid Unity ISIS System Setup Guide, located on the Documentation DVD, contains 
complete instructions for loading the software onto the system that should be followed each 
time you load the software. The following sections include important information about each 
installation. 

Compatibility Driver Dialog Box

During the client software installation, a dialog box appears asking if you need the 
Compatibility drive loaded. Select Yes if you have one of the following Avid editing 
software versions. Select No if your Avid editing version is not listed.

• Media Composer Adrenaline — v1.6.3 - v1.6.7

• NewsCutter Adrenaline — v5.6.3 - 5.6.7

• Media Composer Meridien — v12.5 

Changing the Default Drive for the System Director Software 

During installation, the installer defaults to loading the System Director software on drive 
D:. You can change that location by specifying a different drive for installation.

If you install the application to a location different from the default D: drive, and then later 
install the application to the default drive, the new software does not function properly. You 
can correct this either before or after installation by copying three files from one drive to the 
other.

To change the default installation directory before re-installing the Avid Unity ISIS 
application:

1. On the D drive create the following directory structure. 

n You must spell the names exactly as they appear on drive C:. 

D:\Program Files\Avid Technology\AvidUnityISISSystemDirector

2. Copy the following files from the AvidUnityISISSystemDirector folder on drive C: to 
the AvidUnityISISSystemDirector folder you created on drive D:. 

- Partition0

- Partition1

- PartitionDump.bin
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3. Complete the installation, checking to see that installer places the application in the 
folder that was created and the System Director uses the correct files.

To change the default installation directory after re-installing the Avid Unity ISIS 
application:

1. Stop the System Director Service.

2. Copy the files listed below from their location on drive C: to the same location on 
drive D: 

- Partition0

- Partition1

- PartitionDump.bin

3. Start the System Director Service.

Drivers and Installers Available on DVD

The Avid Unity ISIS Installation DVD contains the following installers and drivers:

• Installers — The following installers are needed when connecting to an Avid Unity ISIS 
system. How to load the Installers is explained in the Avid Unity ISIS Setup Guide or the 
specific documentation for the device, such as AirSpeed. 

- System Director

- Avid Unity ISIS Installers 

- Windows Client Installer (this is the windows client installer used only if loading 
the client directly from the DVD)

• Drivers — The following drivers can be found on the Avid Unity ISIS DVD:

- Drivers, firmware, and configuration files for external switches

- Drivers for the supported Intel Ethernet boards 

- Java™ 

Java Runtime Environment

The Avid Unity ISIS Client Manager requires v1.5.0 or higher of the Java Runtime 
Environment (JRE). Avid provides a qualified version of JRE for Windows systems on the 
Avid Unity ISIS DVD in the [DVD drive]:\Java folder.

For clients using a Macintosh system, download the Java software from the Apple® Web site 
(www.apple.com) or use the Apple Software Update.

http://www.apple.com
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Flash Player Software

To use the Administrator tool, you need to have Macromedia® Flash® Player installed on 
your system. If you encounter problems with the Administrator tool display, you might have 
an outdated version or multiple versions of Macromedia Flash Player installed. Uninstall any 
previous versions of Flash Player and install the Flash Player included on the Avid Unity 
ISIS installer DVD.

Redistribution of Data

Redistribution of data in it’s simplest form is taking data from a location and moving to 
another location. Redistribution occurs when using the Administration Tool to add or 
remove an ISB from a Storage Group, moving a workspace from one storage group to 
another, or performing other selected functions. See the Avid Unity ISIS Administration 
Guide for an explanation on how to add and remove ISBs from the Storage Group.

• One example of redistribution is taking data from an ISB that had initially stored the 
data or from a mirrored location if the original isn’t available, and placing it onto an 
existing ISB so it is not lost when you replace a bad or failing ISB with a new one.

• A second example of redistribution is after you place the new ISB into the system, data 
is placed onto the new ISB from other ISBs and also possibly new data from clients.

Since each customer can have a different number of engines, a different numbers of clients, 
and can be configured in different ways, Avid cannot define the exact time it will take to 
perform a redistribution. What Avid can do is:

• Provide Guidelines for Redistribution — These guidelines help you make the proper 
determination as to when and how to perform redistribution.

• Help you Understand Redistribution Workflows — These workflows explain how you 
might be able to determine how long redistribution will take, by taking into account 
specific variables.

Guidelines for Redistribution

Redistribution occurs when you remove one or more ISBs from a Storage Group or when 
you add one or more ISBs to a Storage Group. Use the following precautions when handling 
ISBs:

• Handle ISBs carefully, physical shock such as dropping can permanently damage the 
disk drives.

• Do not force or slam an ISB into the midplane when inserting it into the chassis. This 
can cause errors on adjacent blades that are writing or reading.
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The following guidelines are the recommended practices when invoking a redistribution. 

n The following information assumes mirrored workspaces.

Redistribution has been divided into the following two categories:

• Load — Load is defined as having clients reading and writing. 

• No load — No load is defined as having clients attached, but clients are not doing any 
reads or writes. 

Whenever you perform a redistribution you should attempt to observe the following 
guidelines: 

c Any workspace that has had a full redistribution performed after upgrading to 
ISIS v1.1 or any new workspace that has been created in ISIS v1.1 will not be usable if 
the system is downgraded to v1.0.

• Do not physically remove an ISB until the ISB has been removed from the file system 
and the redistribution is complete. 

• When redistributing under load, allow a redistribution to complete before invoking a 
second redistribution.

n If more that one ISB is physically removed from a storage group before performing a 
redistribution, data loss can occur. You might be removing the mirrored drive used by the 
first ISB that was removed.

Understanding Redistribution Workflows 

The following sections explain some workflows that help you understand the number of 
clients that can be used during redistribution and how to determine how long distribution 
might take. A area of improvement regarding redistribution is with the time required for a 
redistribution to complete. If upgrading from v1.0 to v1.1, all workspaces must undergo a 
full redistribution process to take advantage of the improvements.

• Client Performance During Redistribution

• Single Blade Add Redistribution Times

• Single Blade Removal Redistribution Times
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Client Performance During Redistribution

One area of significant improvement in 1.1 has to do with client performance during 
redistribution. In almost all cases, the editor clients will not suffer a degradation when a 
redistribution is initiated.

• Adding ISBs to an existing Storage Group will not impact clients and servers that are 
currently working.

• When removing multiple ISBs from a Storage Group, ensure that the existing load to the 
Storage Group does not exceed the available bandwidth of the remaining ISBs.

Single Blade Add Redistribution Times

Use the following tables to determine the amount of time required when adding a single ISB 
to an existing storage group. The tables are based on the load to the storage group, the 
capacity of the ISB, as well as the amount of data that added to the blade.

Single Blade Removal Redistribution Times

Below is information, based on the usage of a the Storage Group, on how long a 
redistribution takes for a single ISB to be removed from a Storage Group.

Use the following table to determine the amount of time required when removing a single 
ISB from an existing storage group. The tables is based on the load to the storage group, the 
capacity of the ISB, as well as the amount of data that will be removed from the blade.

i500 Single Blade Add (Hours to Complete)  

Data on ISBs

System Load 25% Full 50% full 100% Full

No Load 1.5 3 6

50% Load 2 3.5 7.5

i1000 Single Blade Add (Hours to Complete)  

Data on ISBs

System Load 25% Full 50% full 100% Full

No Load 3 6 12

50% Load 4 7 15
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The times in the following tables are based on a blade that has failed and the amount of time 
required to protect the data that exists on the remaining blades in the Storage Group. It is 
always advised that if an ISB is to be removed and is functional that it should participate in 
the redistribution process. This will increase the overall time to complete but will prevent 
data loss in the event of blade failure during the redistribution process.

500 GB Blade — Time To Completion with No Load  

Chassis 25% Full (Minutes) 50% Full (Minutes) 100% Full (Minutes)

1 18.3 36.6 73.1

2 7.8 15.6 31.2

3 6.1 12.1 24.3

4 5.0 9.9 19.8

5 4.5 9.0 17.9

6 4.1 8.2 16.3

7 4.1 8.2 16.3

8 4.1 8.2 16.3

10 4.1 8.2 16.3

12 2.6 5.1 10.3

500 GB Blade — Time To Completion with a 50% Load  

Engines 25% Full (Minutes) 50% Full (Minutes) 100% Full (Minutes)

1 38.6 77.2 154.3

2 34.7 69.5 138.9

3 34.7 69.5 138.9

4 31.6 63.1 126.3

5 30.5 61.1 122.1

6 29.6 59.1 118.2

7 28.6 57.3 114.6

8 27.8 55.6 111.1

10 27.8 55.6 111.1

12 27.8 55.6 111.1
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I TB Blade — Time To Completion with No Load  

Engines 25% Full (Minutes) 50% Full (Minutes) 100% Full (Minutes)

1 36.6 73.2 146.4

2 15.6 31.2 62.5

3 12.1 24.3 48.6

4 9.9 19.9 39.7

5 9.0 17.9 35.9

6 8.2 16.4 32.7

7 8.2 16.4 32.7

8 8.2 16.4 32.7

10 8.2 16.4 32.7

12 5.2 10.3 20.6

I TB Blade — Time To Completion with a 50% Load  

Engines 25% Full (Minutes) 50% Full (Minutes) 100% Full (Minutes)

Chassis 25% Full 50% Full 100% Full

1 77.3 154.5 309.0

2 69.5 139.1 278.1

3 69.5 139.1 278.1

4 63.2 126.4 252.8

5 61.1 122.2 244.5

6 59.2 118.3 236.7

7 57.3 114.7 229.4

8 55.6 111.2 222.5

10 55.6 111.2 222.5

12 55.6 111.2 222.5
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Scaling and Connecting an Avid Unity ISIS System

This section contains the following information:

• Configuration Overview 

• Client and Server Scalability Guidelines

• Client Connectivity Guidelines

Configuration Overview

You must understand the building-block principals for successfully scaling the 
Avid Unity ISIS products along with expected performance for clients and servers as well as 
rules for connectivity. To do this you must understand two basic concepts:

• Engine Performance 

• Client Performance 

Engine Performance

Scaling the Avid Unity ISIS environment is based on the amount of bandwidth an ISIS 
engine (or several engines) are able to provide. A single ISIS engine is made up of 16 Avid 
ISIS Storage Blades and can produce upwards of 240 MB/s or 300 MB/s aggregate 
throughput by serving multiple clients simultaneously (see the following table). More 
regarding clients and resolutions will be explained later. Scaling an Avid Unity ISIS media 
network beyond a single ISIS engine will effectively scale in increments based on a single 
engine performance. 

The following table defines Avid Unity ISIS media network throughput capabilities based 
on the number of ISIS engines in use. 

Engine Performance  

Number of ISIS 
Engines

DV25/50 and IMX 30/50 
Throughput

DNxHD 145/120 
Throughput

1 300 MB per second 240 MB per second

2 600 MB per second 480 MB per second

3 900 MB per second 720 MB per second

4 1200 MB per second 960 MB per second

5 1500 MB per second 1200 MB per second

6 1800 MB per second 1440 MB per second

7 2100 MB per second 1680 MB per second



Scaling and Connecting an Avid Unity ISIS System

19

Client Performance

The expected level of performance of an ISIS client can range from the Media Composer 
Adrenaline family of products to Workgroup solutions such as AirSpeed and 
TransferManager. Since all clients do not behave the same way, some clients have better 
overall performance than others depending on the client hardware and software architecture.

Avid Adrenaline Media Composer and Avid Symphony Nitris Performance

The following resolutions for the Media Composer Adrenaline family of products and Avid 
Symphony Nitris system have been tested and are supported for the V1.0 C release of Avid 
Unity ISIS media network in both NTSC and PAL. As enhancements to Avid Unity ISIS 
software occur the number of resolutions will increase.

• 2:1

• 3:1

• 15:1

• 20:1

• MPEG–2 Proxy for InterPlay

• HDV, DV50, and DV25

• IMX50 and IMX 30

• DNxHD145/120 (see note)

n At this time, the editor is qualified with the capability of using 2 streams of video and up to 8 
tracks of audio. This level of functionality allows for better scalability of the ISIS 
environment while still allowing an adequate degree of client performance and functionality. 
Attempting to increase the clients stream playback may result in unexpected results for the 
client but should not impact the ISIS system. Other clients, such as MediaManager Selects, 
are only capable of playing 1 stream of video.

8 2400 MB per second 1920 MB per second

9 Not supported Not supported

10 3000 MB per second 2400 MB per second

11 Not supported Not supported

12 3600MB per second 2880 MB per second

Engine Performance (Continued)  

Number of ISIS 
Engines

DV25/50 and IMX 30/50 
Throughput

DNxHD 145/120 
Throughput
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n DNxHD might result in skipped video frames during a heavy system load. To prevent this, 
you should use 2 streams of video and 4 tracks of audio.

Avid AirSpeed Performance

The AirSpeed performance is governed by the resolution selected within the AirSpeed as 
well as the mode of operation. For the most up-to-date number of combined AirSpeed 
servers and Avid editing systems that have been qualified on a Avid Unity ISIS, check the 
Avid Knowledge Base.

n Avid recommends always using the Avid Unity ISIS in a mirrored state.

TransferManager Performance

The TransferManager server varies in performance based upon the Avid products and third 
party solutions that are integrated into the Avid Unity ISIS media network. 

Scaling purposes must be handled on a case by case basis due to the dynamic nature of the 
product.

Bandwidth Reservation 

Bandwidth Reservation is a feature that controls the amount of bandwidth a device can use 
in the ISIS media network. The idea is to better manage the overall rate of devices, such as 
AirSpeed devices, and prevent bandwidth starvation in the ISIS media network that could 
impact clients that need data rates to support real-time effects. For ISIS media network 1.0, 
the only devices that will utilize Bandwidth Reservation will be AirSpeed devices. For 
AirSpeed devices, the templates listed in the previous section dictate the amount of 
bandwidth that it is allowed to use. However, the bandwidth allocation in the Administration 
Tool must be set to allow the reservation. For example, if an AirSpeed is configured as 
DV 50 playout, then the bandwidth for that device must be set for 26MB/s in the 
Administration Tool in order for the AirSpeed to access the workspace and reserve 
bandwidth. If the bandwidth is not set, the AirSpeed will not be able to access a workspace.

Client and Server Scalability Guidelines

When scaling an Avid Unity ISIS media network, you first need to understand how much 
bandwidth is available based on the number of ISIS engines in use. It is also important to 
understand how the ISIS engines are segmented by way of Storage Groups, which will 
define the number of ISIS engines and ISIS Storage Blades that a client or several clients can 
access. For example; an ISIS media network can consist of 3 ISIS engines, but the engines 
could be segmented into Storage Groups of 2 and 1 ISIS engines respectively. 
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n Storage Groups are recommended to be sized in increments of ISIS engine. While Storage 
Groups can be created with partial ISIS engine, performance and sizing scalability cannot 
be guaranteed. 

Due to the dynamic nature of an ISIS media network environment, configurations can be 
different for every site, especially for broadcast facilities that have a wide range of 
Workgroup products. Because of this, all the rules regarding a configuration in terms of 
client/server count cannot be defined in a document. Avid uses a configuration tool to 
calculate configuration possibilities for new and existing sites. Contact your local Avid 
representative to make use of this tool when ordering or modifying a system.

Scaling Editor Clients

When used as a guideline, the following table indicates the number of clients a Storage 
Group could possibly support based on the number of ISIS engines in the Storage Group and 
client resolution. However, the total number of clients that can be supported will be limited 
by network connectivity as well as other components that are using the Storage Group. 

Client Connectivity Guidelines

This section defines the rules and strategies of connecting clients and servers to the ISIS 
media network, from network recommendations to the use of external switches. To do this 
you must look at the following:

• Client Connection Speed

• Network Addressing

Client Connection Speed 

Zone 1 clients must use 1 Gb connections to the ISS. The ISS no longer negotiates at any 
rate below 1 Gb. If 100 BASE-T connections are needed, connect the clients or server to 
external switches configured for Zone 2 or 3.

n AirSpeed devices and TransferManagers must be connected as Zone 1 clients.

Network Addressing 

In order for proper operation of the ISIS media network, clients must be configured on the 
same broadcast domain as the ISIS, ISSs and System Director. The ISIS network topology is 
split into 2 separate broadcast domains, with one broadcast domain represented by the ISIS 
ISSs on one side of the ISIS engine and the 2nd domain represented by the ISIS ISSs on the 
other side. The default network configuration looks like the following:
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For more addressing information see “IP Addressing Overview”, in the Avid Unity ISIS 
Setup Guide. If the end user needs to change the network broadcast domains of the ISIS 
media network, the clients and servers that are to be attached must change and be outside the 
range of addresses used for the ISSs and IXSs. 

The following table lists possible port configurations based on the above policies. For each 
ISIS engine listed in the table, there is an associated Foundry FES-X424. The exception is 
when you have 3 ISIS engines, you do not receive any additional ports due to the IXS 
module replacing the ISS module. 

n The number of ports shown above is based on available ports and is not indicative of what 
the Avid Unity ISIS engine can support based on overall system bandwidth.

Each ISS is rated at 260MB/s of network bandwidth. This bandwidth is separate from the 
bandwidth available in an ISIS Engine. The 260MB/s network bandwidth can be allocated to 
all Zone 1 clients on a single ISS or it can be spread across ports used for Zone 1 clients as 
well as the 10Gb port used for Zone 2 and 3 client connectivity.

Default Network Addresses for Avid Unity ISIS Engines  

Location Network ID Subnet Mask

Left side of engine 192.168.10.0 255.255.255.0

Right side of engine 192.168.20.0 255.255.255.0

Available Zone 1 and 2 Ports  

Available Zone 1 and 2 Ports

External 
Switches ISIS Engines VLAN 10 VLAN 20

Total 
Ports

1 1 6 10 6 10 32

2a

a. Number of switches stay the same due to IXS connection in the engine instead of ISS when going to three engines.

2 12 20 12 20 64

2a 3 12 20 12 20 64

3 4 18 30 18 30 96

4 5 24 40 24 40 121
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The 10-Gb port is able to support up to 230MB/s of the total 260MB/s available in an ISS. 
The remainder of the network bandwidth on that ISS can then be allocated to Zone 1 clients.

For example, 14 DV 50 clients are connected to an Avid Unity ISS by way of a supported 
Zone 2 switch. The total bandwidth of these clients is approximately 224MB/s. This allows 
for up to 36MB/s of additional network bandwidth that can be used by Zone 1 clients or 
servers on the same ISS.

The following guidelines must be followed to maintain proper network performance:

The following two tables describes the number of supported clients in a Zone 3 
configuration. 

Number of Links between Layer 3 (L3) Switches Vs. Number of Clients  

Number of 1-Gb Links 
Between AvidL3 Switch to 
House Core Switcha 

a. This uses 1 Gb X-links

Maximum DV25 or IMX30 
Clients 

Maximum DV50 or IMX50 
Clients

1 15 8

2 30 15

4 50 32

Number of Clients per House Edge Switcha  

a. Assuming 1 Gb uplink.

Client Type
Maximum DV25 or IMX30 
Media Clients

Maximum DV50 or IMX50 
Media Clients

MediaManager Select 15 NA

Avid iNEWS Instinct 15 8
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Known Issues

The following sections describe known issues with the Avid Unity ISIS software. When a 
workaround exists, it appears in the paragraph directly following the issue description. 

➤ As an editor client you might see the following:

- Semaphore Time-out

- Decomp Stream

- Video or Audio overruns

Workaround: Clear the error message and re-try the function. If it continues to fail, call 
your Avid Representative.

➤ In order to play video from applications such as MediaManager Select and Instinct, your 
Avid Unity ISIS username must match your Windows login name. However it is not 
necessary for your Windows password to match your ISIS password.

➤ Before installing or updating the Avid Unity ISIS Client Manager software on your 
Macintosh system, you must unmount any mounted workspaces and exit the Client Manager 
software.

➤ Close all applications that use an Avid Unity ISIS workspace before attempting to restart or 
shut down your Macintosh client, and unmount the workspace. If a workspace is mounted 
when attempting to shutdown a Macintosh system, the Macintosh might enter an 
unresponsive state, 

Workaround: If your Macintosh becomes unresponsive, you need to force a shut down by 
holding in the power button until the Macintosh system powers off.

➤ If you attempt to log in and receive the error “Invalid username or password. Please try 
again”, you might have Force Manual Creation checkbox selected. 

Workaround: Disable the “Force Manual Device Creation” check box or have the Avid 
Unity ISIS Administrator use the Administration Tool to create the Device you are logging 
into.

n Although not as frequent, other problems can also cause this error.
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➤ After powering down and powering up an Avid Unity ISIS media network, some switches 
intermittently either take on a duplicate IP address used by another switch or resets to 
factory default.

Workaround: 

t If your media network has multiple engines, disconnect the Hi-Gig links and re-add 
the engines to the stack.

t If your media network has a single engine, use the management port to reconfigure 
the IP Addresses.

➤ If you are unable to re-connect to an unmounted workspace, you should restart the client.

➤ A delay up to 45 seconds is seen for the workspace to show after you reboot a client and map 
a workspace for the first time.

Workaround: You must perform the following:

1. Go to the System32 directory and browse to \drivers\etc and look for the lmhosts file. 
You might see the lmhosts.sam (sample file). To edit the lmhosts file (or create one if it 
is not there) use Notepad. Do not use Wordpad. 

If there are already entries in the file, add the following loopback entry into it. Do not 
change any other entries or add any extra characters. There should be at least one space 
between each entry. Do not use tabs in this document.

127.0.0.1 <virtual name of System Director> #PRE

The virtual name should match exactly to what is entered into the System Director 
Control Panel. 

2. Save this file as LMHOSTS (with no extension) to the following location:

c:\windows\system32\drivers\etc

n Be aware the your system might not be displaying extensions if you have the Hide Extensions 
option selected in the Windows Explorer > Tools > Folder Options > View tab.

3. Enable the operating system to look at the lmhosts file by:

a. Right clicking My Network Places and select Properties

b. Right click on any “Local Area Connections” and select properties.

c. Select Internet protocol TCP/IP and click Properties.

d. Click Advanced.

e. Click the WINS Tab, check the Enable LMHOSTS lookup, and click OK.

f. Close all windows by clicking OK in each Window.



 

26  

➤ Deleting a ISS from a stack does not clear engine configuration.

Workaround: Use the Reset Factory defaults button to clear stack configuration info.

➤ Clips are not visible in Media Tool when you perform the following sequence:

1. Open Media Tool.

2. Select the drive and project that have clips and master clips.

All Master clips are visible.

3. Close Media Tool.

4. Open Media Tool.

5. Select the same drive and project that have clips and master clips.

6. No clips are visible.

Workaround: Re-launch Media Composer. When you open Media Tool the clips are now 
visible.

Accessing Online Support

Avid Online Support is available 24 hours per day, 7 days per week. Search the Knowledge 
Base to find answers, to view error messages, to access troubleshooting tips, to download 
updates, and to read/join online message-board discussions.

To access Avid Online Support:

t Go to www.avid.com/onlineSupport/.

Technical Support Information

Most products feature a number of coverage options. Avid Assurance service offerings are 
designed to facilitate your use of Avid solutions. Service options include extended telephone 
coverage, automatic software maintenance, extended hardware warranty, and preferred 
pricing on replacement parts. Offerings and options may vary by product and are not 
available for all products.

For more information regarding Avid’s service offerings, visit www.avid.com/support or call 
Avid Sales at 800-949-AVID (800-949-2843).

Program availability and details might vary depending on geographic location and are 
subject to change without notice. Contact your local Avid office or your local Avid Reseller 
for complete program information and pricing. However, if you need help locating an Avid 
office or Avid Reseller near you, please visit www.avid.com or call in North America 
800-949-AVID (800-949-2843). International users call 978-275-2480.

http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com
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